GUIDELINES FOR PRODUCING A FAMILY HISTORY BOOK
USING 100% FREE SOFTWARE

T

his guideline will provide you with the information you need to create a family history book (or any
other kind of book) at minimal cost. All of the software that's used is “free”ware – doesn't cost a
dime. This pamphlet will lead you step-by-step from the initial organizing of material, downloading the
freeware, creating the project, and finally preparing a print-ready copy. There are many screen shots
included. I have used this on Windows XP, Windows 7 and Windows 8.1, the most current version.
There are many programs that will accomplish the same results, but I've found the ones included
herein to be virus free, very fast, and intuitive to use. You'll find that most of them have a multitude of
features which you may want to explore. I only include the features that are necessary for a book
production of this kind.
SOFTWARE

H

ere's a listing of the various programs, with a brief description of their use, and the links to the
websites where they may be downloaded. If you are reading this on your computer in the .pdf
format, you should be able to just click on the blue link and go right to the website.
LIBRE OFFICE http://www.libre-office.theappcenter.com/
This is an entire suite of programs that virtually replaces Microsoft Office. Two applications in this
suite will be used: the word processor (as the basic document) and the presentation application (for
captioning pictures.)
JING http://www.techsmith.com/jing
This strangely-named program allows the capture of portions of the current screen, and the captured
image may be saved or copied for further processing. It's an ideal way to capture specific images
from websites that include pictures that you may want to include.
IRFANVIEW http://www.irfanview.com/
Another oddly-named program (“Irfan” is the name of the author) which provides simple, but powerful
image processing, such as cropping, converting to gray scale, and balancing brightness and contrast.
FAST IMAGE RESIZER http://fast-image-resizer.en.softonic.com/
Provides the means to quickly and simply reduce the size of large images to manageable proportions
for inserting in the book. With a simple drag and drop, it will re-size multiple images in seconds.
SUMATRA http://blog.kowalczyk.info/software/sumatrapdf/free-pdf-reader.html
Although you may already have Adobe Acroreader for .pdf files, I much prefer Sumatra – it's extremely
fast, and I use it as my default .pdf file reader.
ORGANIZING YOUR FILES AND DESKTOP

M

ost PCs have the capability of supporting two monitors. I have two monitors side-by-side, and
use the second one as an extension of my desktop. One application can be full-screen on one
monitor, and another on the second – it allows copying and pasting between applications without
having to click back and forth. Monitors are fairly inexpensive these days. Fry's has 24” ones for
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under $100, and E-Bay and Amazon have them for even less. Certainly not required, but for any
serious writing work, including insertion of pictures, I couldn't live without them after using them for
several years.
I like to put shortcuts on my desktop for folders and applications that I'm going to frequently use, rather
than having to dig into layers of directories.

The screen shot on the left above shows my arrangement of folders that contain the pictures for the
book. It also includes an icon that when clicked, brings up the book itself. The shot on the right
includes shortcuts to the programs I will be using. There is no “JING” shortcut – it automatically is
started when the computer is initially booted when turned on, after the initial installation of the
program.
The folders for pictures include:
Raw Pictures – pictures that have been captured from internet websites using JING, scanned photos,
downloaded pics from sites such as Ancestry.com, pictures emailed to you as attachments, pictures
taken by your digital camera that have been loaded into your computer, and any others that you have
obtained.
Modified Pictures – from your raw pictures, those that have been cropped, converted to gray-scale,
contrast/brightness corrected and re-sized.
Captioned Pictures – pictures from the modified folder that have had captions incorporated, borders
established, and are ready to be inserted into the appropriate place in the book.
Pictures in the Book – a repository for those pictures that have already been inserted into the book.
They are retained here in case you want to use them again, and to keep track of what's already in the
book.
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SELECTING THE FORMAT FOR THE BOOK

T

his only has to be done once, upon commencement of the project. Once it's done, and the book
saved, clicking on the book's icon will bring it up with all the established characteristics set, and
you can continue where you left off. This guideline document was prepared using exactly the same
processes that are explained herein. It's assumed that the reader has a reasonable knowledge of
computer operation, and is familiar with Windows, including the system of files, folders, and
directories, as well as mouse commands. If you're running a Mac, there probably are identical or very
similar applications available to you.
The first step is to bring up a blank sheet using Libre.
Clicking on the Libre program icon will bring up this
screen. Click on “Text Document.” This will bring up
a blank page. Next, we will select the attributes we
want for our document.

Click Format → Page

You will then see the screen at
left. Adjust the margins as you
wish, sides and top/bottom,
click Apply then OK.

We next will select some of the
other attributes.
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The top of the page has tool bars. You have many fonts to choose
from – I prefer Arial for its simplicity and readability. Click on the
drop-down as shown for Arial. This will remain your default font for
the entire document.

Next, select font size. 11 is a good size – that's what this guideline
uses, along with the Arial font. If you expect older readers with poor
eyesight may be your primary audience, you might want to increase
the font size.

Margins may be set on either side, centered, or justified. The default
setting that I use is shown here, which will justify both the left and right
margins, which gives a neat, professional look to the text.

Creating a footer with sequential page numbers is probably the most complicated task, and is not
particularly intuitive.

While on the first page of your document, select “Format” and
then “Page” from the drop-down menu.
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This screen will then appear. Select
the “Footer” tab, and check the boxes
as shown here.
Click “Apply” and then “OK” and you
will then have created a footer for every
page.
The bottom of the page will now
contain a “footer” field as shown below.
This will only be visible when you place
your mouse's insertion point within the
footer field. You do that by clicking
your mouse arrow/cursor inside the
field.

While the insertion point is within the footer field, go
back to menus at the top of the page. Select
“Insert” then “Fields” and then click “Page Number.”
You now will have a number 1 appear in the field.
This will be sequentially repeated (2, 3, 4, etc.) for
every following page.

In order to create a centered or right-justified version as shown here, type “Page” in front of the
shaded page number. Then go back up to the tool bar at the top, and select font style, font size, and
click on the centering icon. I use Arial, 10 point, and center. You could also type “Page Number” and
right-justify if you wish. Although the number appears shaded, when you view the print preview or
actually print the document, the shading is not present.
You are now ready to enter your narrative. If you have pictures edited and ready to imbed, you can do
it as you go, or wait until you've completed all of your narrative and embed them later.
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ENTERING TEXT

N

ow that the page attributes are set up, the text may be entered in the same way as you are used
to doing when writing emails or letters to be printed. There are a couple of tricks that will jazz up
the presentation.
One of them is to use drop caps – these may be used at the
beginning of a leading paragraph, such as I've done in this
document. Highlight the first few words of the paragraph for
which you want to begin with a drop cap. (you don't have to
highlight the entire paragraph.) Then right-click over the
highlighted area, and select “Paragraph.”

This will bring up a screen like the one on the right.
Select the “Drop Caps” tab, Check the box labeled
“Display drop caps”. Then there are several options to
be selected, such as number of characters, the height
of the character(s) in text lines, etc. Select what you
will, and click on “OK.” This document uses 2-line
height drop caps. You can experiment to see what you
like. Note that the shading of the dropped-cap will
appear only in this draft copy, similar to the page
number discussed before. The shading will disappear
upon printing.
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Another technique is to differentiate quoted text from the main body by modifying the left and right
margins, and the font characteristics. As an example, let's assume that you have the following in your
narrative:
–------------------------------------------------------...James A. Linforth, arrived in G.S.L. City in advance of his company of emigrating saints, which he
had left west of Laramie, July 25th. The following detailed account of their journey is from the pen of
Elder Linforth:
"It was decided by Elders Miller and [John] Cooley that we should start on Thursday, the 9th of
June. Operations were commenced early in the morning, and then began the yoking of refractory
cattle, and the initiation of "greenhorns" into the art and mystery of teaming.”

The consequence was, that Elders Miller and Cooley had to do nearly all the work, which nearly
brought noon before we could start. …
–------------------------------------------------------This clearly differentiates the cited passage. The procedure is
to highlight the text to be modified, and then use the little icons
up in the ruler bar to move the margins in on each side. This
will adjust the margins for only the portion you have highlighted.
While still highlighted, you may modify the text. In the example above, I reduced the font size to 10,
made it italic, and indented the right and left margins with the ruler bar icons.
SELECTING AND EDITING THE PICTURES – CAPTURING USING “JING”

w

hen you have installed “Jing” and re-booted your computer, you
will notice a yellow dot at the top of your screen. They call this a
“sun” for obvious reasons. You can drag and drop this to one side if you
wish, so it doesn't interfere with your current application. When you
hover your mouse arrow over this sun, three “rays” appear. By clicking
on the “Capture” ray, crossed yellow lines will appear. Use these to form
a yellow rectangle around the portion of the screen that you want to
capture. When this rectangle is formed, the bar at left will appear. Click
on “capture image” then click on the button to the right of the “capture
image” button, and save it to your “raw pictures” folder (or to your
desktop, and then drag/drop it in your “raw pictures” folder). The Jing on-line help has some great
video tutorials on the use of all of the features. The help file may be accessed by clicking on the
“More” ray. There are a variety of other features you can access after you initially capture an image
using Jing if you want to experiment with them.
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Assume that you've found a page similar to the above on a
website that includes an image that you want to retrieve.
Sometimes you can just right-click on the image and save it
to file, but sometimes you can't do that. Jing allows you to
retrieve just a portion of the screen and save it. You can
frame the ship with the yellow rectangle, and save it to file for
further editing, as shown at left.
SELECTING AND EDITING THE PICTURES – EDITING USING “IRFANVIEW”
I use Irfanview as my default picture
viewer. It is extremely fast and quite
powerful, and doesn't have the
“learning curve” that apps like Adobe
Photoshop do. Supposing you have a
picture on file like the one on the left.
All you want is the man in the center's
picture for your book. You also want it
in gray-scale rather than sepia tone,
and you want to
tweak
the
brightness
and
contrast. Irfanview
will do all that, and
more.
Load the pic into Irfanview and click and drag the mouse to make a rectangle
around the section that you want to crop to. In Irfanview's edit menu, select “Crop
Selection.” →
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You want this to be in gray-scale, so you make the
following selection from the menus: in the “Image”
menu, click on “Convert to Gray scale. →
It will change to look like the image to the left, without
the sepia tone.
←
Sometimes an image may be washed-out looking after performing this
operation, or maybe an image is faded and indistinct.
There are a couple of fixes that Irfanview has for this, both for gray-scale
and for color pics. The first one to try is the auto-correct feature. From
the “Image” menu, select “Auto adjust colors” (even though it's grayscale) and see if that does the job. →

If you want to manually tweak the pic, from the
same menu select “Color corrections.”
←

This will present you with a screen like the one
below.
For gray-scale, move the sliders for brightness,
contrast and gamma correction around until you get
the best presentation.
“Gamma correction” is
especially critical in this – it has something to do with
relative intensities of
light and dark areas.
Anyway, twiddling it
really works. If you
have a color pic, the
color
balance
and
saturation will help.
When it's to your liking,
click on “Apply to
original” and then “OK”, and save it. There are two choices for saving.
The easiest is to select File → “Save (original folder)” which will
replace the original pic. If for some reason you want to save the
original, select File → “Save as...” and you name the file and choose
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the folder you want to save it into.
SELECTING AND EDITING THE PICTURES – RESIZING USING “FAST IMAGE RESIZER”

Y

ou now have a whole bunch of pictures that have been cropped,
edited and tweaked and are ready to have the final operations
performed on them. Many will probably be very large, which makes them
awkward to maneuver when you're imbedding them in the text. A very
quick and easy solution to this is to re-size them to manageable
proportions before doing the final captioning process. This is very
straightforward and fast, as the software name implies. When you open
this program, a small screen appears somewhere on your desktop. The
“Resolution:” window drop-down has a number of choices. 320X240
(pixels) is a good one for our purposes. This will reduce pics that are
huge (if taken with a newer camera, they could be 2 or 3 thousand pixels
on a side, and maybe be as large as 2.5 to over 3 Megs in file size.) It will reduce them to the
manageable size of 320X240 pixels, allowing them to be embedded easily in the text, and be the right
size for captioning.
The “Options” screen as shown is also good for our
purposes. You want excellent JPEG Quality, and
placing them in a Sub-folder (which is labeled “Resized” in the primary picture folder) makes for
convenient access and manipulation.
←
Open the folder with all of your edited pics, highlight
ALL of them, then drag and drop them into the window
that says “Drop files here.” Once they're dropped, the
program does its thing automatically, and the reduced
pictures will all be in the “Re-sized” folder.

CAPTIONING AND BORDERING THE PICTURES

T

his is the last step before actually embedding the
captioned pics into the text. There are many ways to do
this, and a lot of different graphics programs will allow
captioning, but I prefer the following method, which I think
provides the most professional looking end result. We
return to Libre Office to use the Drawing application.
Save your work, close the Text Document app, recall the
program, and select the “Drawing” application. You will see
another blank page, different from the Text Document that
you've been working on, and there are different tools and
menu items available here.
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The blank page that you see will be where you place images that you
want to caption, create a text box, and enter the caption wording. You
can copy pictures and paste them into the blank page, but the easiest is
to have both the Libre Draw program open and the picture folder open
on the same screen and drag and drop the pictures onto the blank
page. Click on the image, hold down the mouse button, drag the pic to
the blank page and then release the button. You may have to re-size
the picture using the green handles on the image.

Once you have several pictures on the page and have them sized the way
you want them, the next step is to create the captioning text box. There is
a tool bar at the bottom of the page. Click on the “T” in the tool bar. Then
create a text box underneath an image by drawing a
rectangle as shown here.
←When you release the button after drawing the box, it will look like this -->

You may now insert the captioning text. At the top of the page, you
may select the font type and size, and other attributes. For my
captioning, I have used Arial 10, italic, and centered to produce the
desired caption. You can highlight the text box, copy, and paste it and
move it under the other pictures. Since the text attributes are already
set, you can then type in the appropriate text for each caption.
This sequence will take some practice and trial-and-error to become
proficient. The program has very good tool-tips and a help file, to give
some guidance on where to place the cursor to highlight the text box,
how to drag and drop, and how to re-size pictures.

The next steps will show you how to capture these captioned images so they may be embedded in
your book's main pages.
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You now should have several pictures, with captions in
place, on the blank page of the Draw program – two
examples are shown in the left screen shot. When your
mouse pointer is outside of any of the images or text
boxes, the framing will disappear. This provides the
opportunity to capture a clean new image, which contains
both the picture and the caption together, as one single
image.
Now for some comments about “white space.”
This is the white edging around an image that
provides readability when adjacent narrative
text is word-wrapped around the image. In the
example above, note the orange rectangle (the
Jing capture rectangle). On the right and left of
the image it includes some white space. Here
are examples of the same image and wordwrapped text, one with white space and one
without. It's evident why it's so important to
include the white space. Note how the text
runs right up next to the image at the left, and
how much more readable the text is with the
image on the right, with the white space
between image and text.
It's time to capture these newly-captioned images, place them in the “captioned pictures” folder, and
they will then be ready and waiting to be embedded in your book. This is straightforward. Using the
Jing techniques described earlier, place your Jing rectangle around an image (remember to include
the white space!) as is shown in orange at the top of this page. Click “capture image” then “save” and
save it to your “captioned pictures” folder.
EMBEDDING THE CAPTIONED PICTURES INTO THE NARRATIVE TEXT

A

ll of the pictures you wish to include in your book have been captured, converted to gray-scale,
edited for contrast and clarity, captioned, and then recaptured with white-space borders. If you
have composed the entire book narrative, you can insert these pictures one after the other, using the
technique to be described below. Or else you may compose some narrative and insert them within the
paragraphs as you proceed through the composition. My own preference is to compose a section of
text, such as a chapter, and then import/insert the pictures that I've selected.
You can copy a picture and paste it into the book, or drag and drop pictures. With two monitors, I drag
and drop – with the “captioned pictures” folder opened on my left monitor screen, and the book in full
screen on the right monitor screen. Dragging and dropping doesn't actually move the picture – it's
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really just copying the picture into the book, and the original stays in the folder. Once it is copied into
the book, it may then be dragged and dropped into the “pictures in book” folder that's described in
page 2. When you drag/drop between folders, you do actually move the image, rather than just
copying it. This way you can ascertain quickly which pictures you have already put in the book, which
is certainly not an issue when you're dealing with only a few pics, but typically in a book you may have
50 or 60 pictures to deal with, and it's easy to forget which ones you've placed without scrolling back
many pages. I learned this the hard way when I created my 100-page Larsen Family History book –
several times it hit me that I hadn't put in a picture or two, had to scroll back 20 or 30 pages, insert the
pictures, and then rearrange page breaks and locations of other pictures in the succeeding pages
which was a real pain.
The procedure is to drag/drop (or copy and paste) the image into the book at the point within the
paragraph where you want it, re-size it as you wish (although it's already been re-sized. once, you'll
probably want to modify it again), apply word-wrapping, then locate the image to the left or right side of
the page consistent with the paragraph that it's illustrating. It's a pleasing compositional effect to
stagger the placement of the pictures within the text. What follows below is an example of what you'll
see when you first place an image into a paragraph of text:
------------–--------------------------------------------

–------------–------------------------------------------Re-size the image using the little green handles on the corners to a size you wish. Move the picture
to the right or left margin by clicking in the middle of the image and dragging it. Note that the text will
be either under or over the picture, not by the side of it. This requires word-wrapping.
RIGHT-click on the image, select “Wrap” and then click on “Optimal
Page Wrap.” When this is done, you may then move the image into
the text, and it will appear like the arrangement shown on the next
page.
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–------------–------------------------------------------At length we started upon the Plains, and traveled to Six Mile Grove, where we
camped. The road was rather rough, and so were the cattle, and, in the hands of
raw teamsters, nearly unmanageable. Elder miller was here and there and every
where, giving untrained teams, and teamsters in training, many practical
illustrations of the art. "Geeing" and "Hawing" were most forcibly taught, and of
course learned in proportion to the ability of the pupil. The teamster should drive
with the team to the right. When he cries "Gee," the team should go from him,
and when "Haw," come towards him

–------------–------------------------------------------Once placed, the image is “anchored” to that page and paragraph. If you find you need to move the
picture to a different location, or the text paragraph ends up on the next page because of inserting text
into the body of the composition in preceding pages, you usually can't just drag the image between
pages. You'll have to cut it and re-insert it in the new location, and go through the re-sizing, locating
and word-wrapping all over again. After you've inserted a few pictures, you'll get into a groove and it'll
go a lot more quickly. It takes a fair amount of trial-and-error practice to become handy at doing this.
With all of your picture images inserted, do a good proofing of the entire composition, including the
positioning of the pictures as well as the spelling and grammar checks. I prefer printing out a draft,
and proofing from that.
CREATING A COVER SHEET, TABLE OF CONTENTS AND AN APPENDIX SECTION

I

f you take a look at my Larsen Family History book, you'll see that the main composition has page
numbers, but the first section, including the frontispiece/cover sheet, title page and table of contents
are unnumbered. The Appendix section in the back of the book has page numbers, but it uses the
conventional appendix system of lower-case roman numerals. This requires creating 3 separate
segments, which can be merged. The cover sheet that I created involves some graphics manipulation
that's beyond the scope of these guidelines, but of course it doesn't need to be fancy. Since there are
no page numbers to this first segment, it's just a straightforward composition. One point dealing with
blank pages. Both here and in the main book and appendix, blank pages need to be inserted to
make the final printing come out right. A blank page may be created by typing CTRL+Enter at the end
of a page. This will create a succeeding blank page. This blank page will contain only an appropriate
page number entry in the footer section, which will keep the right-hand pages with odd sequential
numbers, the left-hand pages even. New chapters should begin on a right-hand odd numbered page.
FINAL FORMATTING AND PRINTING

T

here are free programs that allow the merging of .pdf files, but that also is beyond the scope of this
guide. The easiest way is to create three .pdf files from the beginning (unnumbered pages), the
main book, and the appendix pages. They could be labeled “Book1, Book2, Book3” or some such,
and the printer could be directed to merge them during the print process. If you wish to merge them
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and create a single .pdf file for the printer, the program I use is PDFILL PDF Tools, which you can find
at http://www.pdfill.com/pdf_tools_free.html. This is a free program, and is very easy to use when
merging .pdf files. It also has a ton of other features to explore.

Libre Office Writer has an export function that makes the creation of the .pdf files
very easy. Click on “File” then click “Export as PDF” and you'll get a screen that
looks like this:
Just use the
default settings,
click on “Export”
and you'll have
your file in .pdf
format. “PDF”
stands for “portable document
format” which as a standard in most
computer environments.

My Larsen family history book was printed by Staples. I provided
them with a flash drive containing the .pdf file (I merged my files)
and selected a premium paper that would not bleed through when
printing both sides of the pages, selected a clear cover, a hard
poster-board back cover and a comb binding. I gave away copies to
my children and grandchildren, and with my brother's family and our
cousins, I had 45 copies produced. They cost about $12.00 apiece
– I was surprised that this was all they cost, since it was 101 pages,
with 50 sheets printed on both sides. I had a huge number of
documents and pictures, including many census records, that I had
accumulated over the years of doing the genealogical research. I
added a bonus to the book – and that was a CD containing about
450 Megs of these documents. I had my CDs created by “Burn-it”
Studio in Sherwood, Oregon, for $2.50 apiece. So with the book, the
CD and its sleeve, the total cost was about $15
A FINAL WORD
If you would like some additional help, or have questions, please feel free to email me at
larsen@jerryjan.com. My website is http://jerryjan.com/, and there are links to my Larsen family
history book and to a copy of these guidelines toward the bottom of the main web page.
Jerry Larsen
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